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Important User Information

Important User Information

This document is intended to provide a good understanding of the functionality offered by
Anybus OPC Server.

The reader of this document is expected to be familiar with high level software design, and
communication systems in general. The use of advanced network specific functionality
may require in-depth knowledge in networking internals and/or information from the offi-
cial network specification. In such cases, the people responsible for the implementation of
this product should either obtain the specification to gain sufficient knowledge or limit their
implementation in such a way that this is not necessary.

Liability

Every care has been taken in the preparation of this manual. Please inform

HMS Industrial Networks AB of any inaccuracies or omissions. The data and illustrations
found in this document are not binding. We, HMS Industrial Networks AB, reserve the right
to modify our products in line with our policy of continuous product development. The infor-
mation in this document is subject to change without notice and should not be considered
as a commitment by HMS Industrial Networks AB. HMS Industrial Networks AB assumes
no responsibility for any errors that may appear in this document.

There are many application of this product. Those responsible for the use of this device
must ensure that all the necessary steps have been taken to verify that the application
meets all performance and safety requirements including any applicable laws, regulations,
codes, and standards

HMS Industrial Networks AB will under no circumstances assume liability or responsibility
for any problems that may arise as a result from the use of undocumented features, timing,
or functional side effects found outside the documented scope of this product. The effects
caused by any direct or indirect use of such aspects of the product are undefined, and may
include compatibility issues and stability issues.

The examples and illustrations in this document are included solely for illustrative purpos-

es. Because of the many variables and requirements associated with any particular imple-
mentation, HMS Industrial Networks AB cannot assume responsibility for actual use based
on these examples and illustrations.

Intellectual Property Rights

HMS Industrial Networks AB has intellectual property rights relating to technology embod-
ied in the product described in this document. In particular, and without limitations, these
intellectual property rights may include patents and pending patent applications in the US
and other countries.

Trademark Acknowledgements

Anybus® is a registered trademark of HMS Industrial Networks AB. All other trademarks
are the property of their respective holders.
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About this Document 3

About this Document

The reader of this document is expected to be familiar with industrial communications and
Anybus Master PCI units and X-gateways.

For more information, documentation etc., please visit the HMS web site, ‘www.anybus.

com.

Document History

Summary of Recent Changes (2.00... 3.01)

Change Page(s)
From Word to InDesign All
Changed order of chapters 5-24
Various updates All

Revision List

Revision | Date Author(s) | Chapter(s) Description

2.00 2009-04-01 [ MiM All First release

3.00 2009-11-04 [KeL All Major rewrite, from Word to InDesign
3.01 2011-03-18 [KaD Anybus Configuration Minor corrections

Conventions and Terminology
The following conventions are used throughout this document:
*  Numbered lists provide sequential steps

» Bulleted lists provide information, not procedural steps

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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Introduction 5

Introduction

Overview

An OPC Server is a software application that acts as an API (Application Programming
Interface) or protocol converter. The Anybus OPC Server will connect to for example an
Ethernet card (using a HMS Transport Provider for Ethernet), and translate the data into a
standard-based OPC format. OPC compliant clients, such as Labview or Scada systems,
can connect to the OPC Server and use it to read and write device data. An OPC Server is
analogous to the role a printer driver plays to enable a computer to communicate with an
ink jet printer. An OPC Server is based on a Server/Client architecture.

Applicable Anybus Products

Description Network Name/Type
Anybus-PClI Any network
Anybus X-gateway Ethernet Slave to any network

Note: The Anybus OPC Server is supported by all X-gateway variants containing the inter-
faces ModbusTCP slave/client, EtherNet/IP slave/adapter, or PROFINET slave/device.

Requirements

The following table lists the necessary items for configuring the OPC for the test applica-
tions described in this document. A power supply 24 V DC and a PROFIBUS cable are

needed in both examples

Description Name/Type Version
OPC server for Anybus Software 201
PCI example
Anybus-PCI PROFIBUS Master AB3502 N/A
Anybus NetTool for PROFIBUS Master Software 141
PCl Interface Design Guide Anybus-S Slave & Master, Parallel | 2.0

Interface Design Guide
X-gateway example
Anybus X-gateway Ethernet to PROFIBUS (Master), for | N/A
example AB7800
X-gateway Manual Gateway Generic Manual 1.11
X-gateway Manual Addendum EtherNet/IP Adapter/Slave Addendum 1.05
X-gateway Manual Addendum Profibus Master Addendum 1.10
Null modem cable (Supplied with the Anybus X-gateway) N/A N/A
Slave used in both examples
Anybus Communicator for PROFIBUS AB7000 N/A
Anybus Communicator Config Tool Software 3.03
GSD-file for the Anybus Communicator GSD-file 1.6
Anybus Communicator PROFIBUS User Manual Manual 2.52
Configuration cable for the Anybus Communicator (supplied | N/A N/A

with the Anybus Communicator)

Note: The GSD files can be downloaded from www.anybus.com

Anybus OPC Server
Rev. 3.01
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Overview 6

More information about the network and the products

The latest manuals, the Anybus Communicator Config Tool, the Anybus NetTool for
PROFIBUS, and the OPC Server for Anybus can be found on the HMS homepage,
www.anybus.com.

The PROFIBUS user organization has a web site, www.profibus.org, where useful informa-
tion about PROFIBUS can be found.

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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This application note describes how to configure the Anybus OPC-server using an Anybus
product, the Anybus PClI-card or the Anybus X-gateway with an Ethernet slave interface.

Example 1 - Anybus PCI-Card

In this example a PCI PROFIBUS master and one slave node are used. Any bus type can
be used, though. Please refer to www.anybus.com for available Anybus PCl-cards. An
Anybus Communicator is used as a slave unit on the PROFIBUS network to loop the data
back to the master unit. Other nodes may be attached to the network, but are not neces-
sary to show the principles of configuration. In the following chapters, configuration is

described step by step.

e

OPC Explorer Scada, etc.
( OPCClient ) ( OPCClient ]
T ]
Arybus
OPC Server QPC OPC Server
A ,Server C
I,Anybus )
:'Transport
\Provider PCI |
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Anybus OPC Server
Rev. 3.01
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Example 2 - Anybus X-gateway

In this second example, an X-gateway with an Ethernet interface is used. As with the first
example there are several options for which network/fieldbus to use, please refer to www.
anybus.com for more information.

Irc
a ™

Application X Application Y
SCADA, ete.

[ OPCClient | OPC Client
,'.IA.nj-'burs @

' OPC Server

!

| HMS Transport
Provider
Ethernet @
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Other network,
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Flowofdata _ .-~
/l\ Fieldbus nemwork
with other nodes

Anybus Communicator
PROFIBUS, for test only

- Loop back dongle

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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Anybus Configuration

The Anybus module has to be configured for the OPC server to go online. Also, the select-
ed network, in this case PROFIBUS, has to be configured.

Note: The configuration of the Anybus Communicator is solely for test purposes.

PROFIBUS Master Configuration

Anybus NetTool for PROFIBUS is used to configure the PROFIBUS master and to set up
the PROFIBUS network.

1. Start Anybus NetTool and start a new project.

2. Locate the ABM-DPV (PROFIBUS master module), Drag and drop it in the window to
the right. The master module is configured as node 1.

Figure 1 Configuration of the PROFIBUS network

3. Add the Anybus Communicator (Anybus Communicator - Slave):

- Import the GSD file if the module is not included in the library by selecting Install new
GSD file in the Tools menu.’

- Drag and drop to add the Anybus Communicator to the network

- Set node number to the same value as is given by the configuration switches on the
module, in this example 11.

1 The GSD-file is available for download at www.anybus.com

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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4. Configuration of I/O data sizes for the slave.

Note: The I/O sizes depend on the application. The I/O sizes configured in this chapter
are examples.

- Right click on the list (begins with Slot) below the PROFIBUS network, see Figure 2 on
page 10.

- Select Module selection and choose 8 bytes for data in and for data out.

- If necessary change the offset address to 0 by right clicking on the Input or the Output
address and select Properties. The start address can then be changed to 0.

Figure 2 Slave I/O size

5. Download the configuration to the Anybus-M PROFIBUS card, see manual for PROFI-
BUS master

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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Anybus Communicator Configuration

To verify the OPC-server configuration, a simple test hardware connection is set up. A
dongle connects the Rx and Tx contacts at the serial port of an Anybus Communicator
(PROFIBUS-DP Serial Gateway). The module will be configured in generic data mode, to
loop back the data to the master.

1. Start the Anybus Communicator Config Tool
2. Set Fieldbus Type to PROFIBUS.DP

Figure 3 Bus type setup

3. Set the module to Generic Data Mode

Figure 4 Protocol mode configuration

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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4. Configure the sub network
- Message delimiter is increased to 10 ms (value = 1000)
- The rest of the values are left at default.

Figure 5 Configuration of sub network

5. Update time for produce transaction is set to 500 ms (value = 50)

6. Set length of 1/0 data to eight bytes.

Figure 6 Configuration of Produce (out) data (length and location)

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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Figure 7 Configuration of Consume (in) data (length and location)

7. Download the configuration to the Anybus Communicatior (see manual)

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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X-gateway Configuration
An X-gateway or a PCI card can be used to verify the OPC configuration. If you use a X-
gateway it will have to be configurated:
1. Start a HyperTerminal window on the PC
2. Connect a serial cable (null-modem) from the PC to the config port on the X-gateway.

3. Open the File menu, click on new, choose the desired COM port and click OK. The
following window will appear:

Figure 8 Configuring the connection in HyperTerminal

4. Make sure that the settings are identical to those shown in the window above. An
alternative method is to download the HyperTerminal session file from www.anybus.
com, double click on it and select COM port.Connect and press ESC. The following
menu will appear:

Figure 9 Anybus X-gateway main menu

Anybus OPC Server

Rev. 3.01 SCM-7032-028
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5. Press 6 and enter the desired configuration. The I/O sizes depend on the application.
The figure below shows an example.
In this case a PROFIBUS Master to EtherNet/IP X-gateway is used. The PROFIBUS
Master is configured for 8 bytes of 1/0O data and the EtherNet/IP for 0 bytes of I/O data.
This means that no bytes are available for the EtherNet/IP scanner on the Ethernet side
and 8 bytes are available for the OPC Server through the transport provider. For a more
detailed description see note below.

Figure 10 The X-gateway configuration

Anybus OPC Server
Rev. 3.01 SCM-7032-028



Anybus Configuration 16

Note: The Transport Provider can use part of the Output Buffer to transfer I/O data. The
amount of data allocated for the Transport Provider is defined as the difference in I/O sizes
between the two network interfaces.

Example (not used in this test application):

I/O Size, Interface A = 8 bytes

I/O Size, Interface B (Ethernet Interface) = 2 bytes

Transport Provider 1/0 Size = (/O Size, Interface A) - (I/O Size, Interface B) = 6 bytes

Interface A Interface B
2 bytes 2 bytes This data is available as I/O Data
on the Ethernet side (e.g. Modbus/TCP, EtherNet/IP)
e e meeemeaoos It is also available for Read Access in the OPC Server
6 bytes s

This data is transported as 1/O Data

6 bytes through the Ethernet Transport Provider
~—
\ Data available for Read and Write Access
. in the OPC Server

Figure 11 The I/O mapping for the X-gateway

The first byte to be used for the OPC Server in this example is byte 3. The first 2 bytes are
used by the EtherNet/IP scanner for 1/0 data.

The mode above, called common access mode, is used when there is an EtherNet/IP
scanner using the X-gateway at the same time as the OPC server. If the Ethernet transport
provider and the OPC server shall handle all I/O data, all 8 bytes are channelled to the
OPC server, and the I/O data size on the Ethernet interface should be set to 0 bytes.

Anybus OPC Server

Rev. 3.01

SCM-7032-028
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Anybus OPC Server

Rev. 3.01

OPC Server Configuration

There are three options (modes) when configuring the OPC server, depending on hardware
and functionality.

Mode When to use
Anybus X-gateway — When you have an X-gateway connected through Ethernet to your computer, and
Shared Access Mode also have other fieldbus communication running through the gateway. In this mode

the EtherNet/IP scanner has access to one part of the output, and the OPC Server
has access to the rest. The OPC Server can not write to the part controlled by the
EtherNet/IP scanner, see “X-gateway configuration” in the previous chapter.

Anybus X-gateway — OPC | When you handle all communication with the X-gateway from the OPC Server. The
Server Only Access Mode | OPC Server has full access to the X-gateway and no EtherNet/IP scanner can be
connected to the X-gateway.

PCI Card When you have a PCI card installed in your computer

Note: The Anybus X-gateway — OPC Server Only Access Mode is hidden by default. It is
enabled in the options dialog. see [Enabling OPC Server Only Access Mode” on page 2§

OPC Server Setup

Most of the configuration is similar in the different modes. When the configuration differs
this will be clearly stated.

1. Set up a new configuration:
- Right click on the OPC Server icon in the Windows toolbar.
- Choose Open Configurator

Figure 1 Open the configuration

SCM-7032-028



OPC Server Configuration 18

2. Choose and configure data source
- Choose data source type suitable to the mode you are using (see modes in table on

bage 17)

- Choose device type, in this example PROFIBUS master
- Name the server, e.g. to Profibus M
- Do not change /O timeout for this example

Figure 2 Choose and configure data source

Anybus OPC Server
Rev. 3.01 SCM-7032-028



OPC Server Configuration 19

Transport Path ID Setup (determination of the link to the actual hardware)

1. Click on the browse button next to the Transport Path ID value field, and the following
window will appear

Figure 3 Transport path configuration

2. Click on Create and select the desired Transport Provider type. The Serial Transport
Provider is not supported in this application.
Depending on example setup choose either PCI Transport Provider (for PCI card) or
Ethernet Transport Provider (for X-gateway).

Figure 4 Select type of transport provider

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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3. If PCI Transport Provider is chosen, enter a name when prompted. The following
window will appear:

7

Figure 5 Choose PCI hardware

4. If you have only one PCI card in your computer, press OK. If you have more than one,
choose correct option from the list above and press OK. The name entered and a Path
ID will be assigned to the path. Click on OK to accept the configuration.

5. If the Ethernet Transport Provider is selecte, enter a name when prompted. The follow-
ing window will appear:

Figure 6 Choose Ethernet connection.

6. Clicking on the button to the bottom right will start Anybus IPConfig. This tool can be
used to configure the IP settings in the X-gateway by double clicking on the desired IP
address.

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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7. Make sure that the Advanced tab has the settings shown in the figure below. Click OK
when ready.

Figure 7 Ethernet connection configuration

8. Select the desired path in the Transport Paths window. Make sure the module is con-
nected and configured for the same sub network as the PC used. As shown above, the
tool Anybus IPConfig can be used to change the IP address of the X-gateway. The path
will now be assigned the name entered by the user and a Path ID. In this case the path
is available for all users, see the note below. Click OK to accept the configuration.

Figure 8 Accept the transport path

Note: There are two types of paths, for the current user or for all users. A path for the
current user can be accessed only by the user who configured the path, and the Path ID

is numbered from 10000. A path for all users is available for all users and the Path ID is
numbered from 1. If several users are using a computer it is strongly recommended to use
a path for all users. To configure a path for all users, the user has to be logged in as a local
administrator. When using Windows Vlsta also the OPC program has to be run in adminis-

trator mode.

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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Adding tags

The next step is to add the variables, the so called tags.

1. Select New Tag Group 1, right click at the first line on the right and choose Add New

Tag.

Figure 9 Inserting the tags

2. Toinsert a new tag, configure the following parameters

Anybus OPC Server
Rev. 3.01

Parameter Description Test setup description Test setup value
Name The name of the tag used in the The tags are named “Input Byte X | “Input Byte X,
OPC Server. and "Output Byte X", where Input “Output Byte X’
contain values coming to the OPC _
. X=0..7
server and Output contain values
going to the fieldbus. X denotes the
number of the variable.
Data source | Data source (hardware) the Tag The data source(s) has been named | Profibus_M
refers to. Click the cell to get a drop | earlier during the configuration
down box with the existing data
sources
Address Address within the Data source to | 8 bytes in each direction are used IBOOO - IB0O7,
which the Tag refers. Click the el- for the test setup QB000 - QB0O7
lipsis button to display the Item Ad-
dress Mapping dialog, see below.
Data type Coerce the value of the OPC Default is used for the test setup Default
Item to the specified type unless which will make the data type used
Default is selected. Also serves as | the same data type as configured
the data type for the Tag. for the address. In this case byte
RIW Sets the access rights for the tag. | The input tags are defined as R. R/RW
Click the cell to get a drop down The output tags are defined as RW
box. for the test setup.
Scaling Displays information about if scaling | No scaling is used for the test setup | Off

is active for the Tag or not, Click the
ellipsis button to display the Scaling
dialog.

SCM-7032-028
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Anybus OPC Server
Rev. 3.01

Parameter

Description

Test setup description

Test setup value

Offline Option

Defines the action that will be taken
for the tag if connection to the data
source is lost. Click the cell to get

a drop down box with the Offline
Actions possibilities

Continue - Tag value freezes when
data source connection is lost and
continues as soon as the connec-
tion is up again

Clear to Zero - Tag value is cleared
to zero when the data source is
lost and will stay cleared even after
reconnection of the data source.

Freeze - Tag value freezes when
the data source is lost and will stay
so0, when the data source is recon-
nected.

In this test, the built-in monitor is
used. You can choose any offline
option available, but the OPC server
will always go to “Continue”.

When running an external client,
any option can be used..

Continue

Value

Displays the Tag value when moni-
toring is enabled

Does not have to be configured.
Only used for monitoring purposes.

Value monitored

Quality

Displays the Tag status when
monitoring is enabled.

Does not have to be configured.
Only used for monitoring purposes.

Quality of the con-
nection

SCM-7032-028
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3. Configure the address.
- Select the data direction for the variable, “Data from Network” for the input variables
and “Data to Network” for the output variables.
- The data type defines the data type for the variable
- Indicate the offset by clicking on the correct Offset value (in this case 0)

Figure 10 Configuring the address

When the setup is complete, the configuration should indicate the following:

Figure 11 The list of tags used in this example (X-gateway - shared access)

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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Going On Line

The final step is to make the server go on line.

1. Click on the server configuration, Profibus_M in this case.
2. Mark the check box Enabled

3. Click on Apply

Figure 12 Configuring the OPC server for on line mode

The Anybus OPC server can now be accessed from client applications and monitored in
the "Server namespace”. For details about how to monitor the variables please see
fng with Built-in Monitor” on page 27,.

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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Enabling OPC Server Only Access Mode

Only the parts of the setup that differ from the setup for X-gateway, Shared Access Mode,
are described here.

Enable OPC Server Only Access Mode

To use this mode, you first have to enable the mode in the Options menu. Choose Edit ->
Options

Figure 13 Enable Anybus X-gateway OPC Only Access Mode
Ensure that the check-box is marked.

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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Testing with Built-in Monitor

Testing the configuration

To test that the OPC Server is working properly, the monitoring function of the OPC Server
is used.
Click on Server Namespace and Choose New Tag Group 1.

Figure 1 Startup Tag Screen
Press the Monitor button at the top of the window.
If the configuration has been performed correctly you should be able to see that the Quality
of the connection is “GOOD” and that the value 0 is displayed for both Input and Output
variables. To write a data value to the node, right click on the Output value and choose
Write value. Enter 1, 2, 3, 4 on the first four Output bytes and the value should change
according to the picture above. Since you have a loopback plug on the ABC you should
shortly after get the data value looped back to the Input variable.

Saving the configuration

To save the configuration, click on File and choose Save As... in the menu. Enter Place and
Name when prompted, and click on Save.

Anybus OPC Server
Rev. 3.01 SCM-7032-028
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